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Next Meeting:  Wednesday, November 12th, 2025 

ARTICLE 

Peering into your data 

At the June 4th Q&A session (https://opcug.ca/

qa_recordings/20250604_PowerPoint.pdf), I presented 

on this topic. As not all members attend Q&A, I decid-

ed to write it up as a newsletter article. 

Analysing lots of data 

Excel allows for a large amount of data with multiple 

data types including numbers, text, charts, pivot tables, 

etc. You can quickly end up with much more than can 

be viewed on a single screen, making it difficult to do 

things such as modifying numbers in a table of data 

while seeing the effect in a chart visualizing that data. 

If the numbers and the chart exist on the same spread-

sheet, you may be only able to see part (or none) of the 

chart as you change the numbers.  

Data and chart on one tab 

In fact, unlike this example, the chart may be located 

very far from the numbers you are working with, mean-

ing you must scroll long distances to see how a change 

in numbers modify the chart. 

by Chris Taylor 

If the numbers and the chart are on separate spreadsheets, it 

can be easy to ensure the numbers and chart are front and cen-

ter when you flip back and forth between the tabs.  

Numbers and chart on separate tabs 

Unfortunately, in that configuration, when you click on the 

Data tab, you can’t see the Chart tab and vice-versa. What if 

you could see both 

tabs at once? You 

can! 

Click the View tab in 

the ribbon. In the 

Window section, click 

New Window.  

(see screenshot page 8)

 
(Continued on page 8) 
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Next Meeting 
 

Wednesday, November 12th 

 

Home Automation – An Introduction 

Speaker: Bill James, VP of the Computer Club of Ok-

lahoma City 

Home automation brings electronic control to house-

hold features, activities, and appliances (IoT). With an 

internet connection, Wi-Fi, a smartphone or tablet, 

and compatible devices, you can easily manage lights, 

thermostats, and more, with voice control as an added 

option.  

This session will be presented by Bill James, APCUG 

Speakers Bureau member and Vice President of Oper-

ations for the Computer Club of Oklahoma City. 

This meeting will be via Zoom video conference. 

Join us at https://tinyurl.com/opcug-meeting. The 

Zoom link will be live at 7:15 pm. The meeting will 

begin at 7:30 pm. 

 

Coming Up… 
 

22 Oct 
Weekly Q&A session 

10 Dec 
VoIP (Voice over Internet Protocol) (details to follow) 
Speaker: Jeff Dubois (OPCUG) 

14 Jan 
Music and its ever-changing delivery 
Speaker: Ray Baxter (APCUG) 

11 Feb 
The Ins and Outs of Electronic Mail 
Speakers: Chris Taylor and Alan German (OPCUG) 

See all our scheduled events here. 

 

OPCUG Presentations at the OPL: 
Monday, 20 Oct, 6:00 pm - 7:00 pm 
Armchair travel – Iceland (Lynda Buske) 
Carlingwood Branch 

Saturday, 25 Oct, 2:30 pm - 3:30 pm 
Armchair travel: Newfoundland (Lynda Buske) 
Centennial Branch 

Monday, 27 Oct, 6:00 pm - 8:00 pm 
Whoa, backup! Effective strategies for keeping your computer files 
safe (Chris Taylor), Emerald Plaza Branch 

Thursday, 30 Oct, 6:00 pm - 8:00 pm 
Quick PC Tips: Enhancing Capabilities and Performance with Free 
Tools (Chris Taylor), Orleans Branch 

Saturday, 01 Nov, 2:00 pm - 4:00 pm 
Restoring old photos (Lynda Buske) 
Cumberland Branch 

Tuesday, 04 Nov, 2:30 pm - 4:30 pm 
Artificial Intelligence (AI): fun and useful tips (Chris Taylor) 
Greenboro Branch 

 
See all our presentations with links to the OPL here. 

CALENDAR 

Event Date Time and Venue 

Next Monthly Meeting Wednesday, November 12th 
7:30 pm via Zoom video conference: https://tinyurl.com/opcug-meeting 
See all our scheduled monthly meetings here. 

Next Q&A Session Wednesday, October 22nd 
Q&A sessions are held weekly except on monthly meeting nights.  
Join us most Wednesdays at 7:30 pm for weekly Q&A. 

Next OPL Presentation Monday, October 20th See all our presentations with links to the OPL here. 

 

https://opcug.ca/events/home-automation-an-introduction/?occurrence=2025-11-12
https://tinyurl.com/opcug-meeting
https://opcug.ca/qa/
https://opcug.ca/events/music-and-its-ever-changing-delivery/?occurrence=2026-01-14
https://opcug.ca/events/the-ins-and-outs-of-electronic-mail/?occurrence=2026-02-11
https://opcug.ca/#upcoming
https://opcug.ca/mec-category/opl-presentations/
https://opcug.ca/mec-category/regular-monthly-meetings/
https://opcug.ca/events/qa-weekly-session/?occurrence=2025-10-22
https://opcug.ca/qa/
https://opcug.ca/mec-category/opl-presentations/
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Social get-together 
 

A 
t the June pizza party, several people expressed interest in having additional in-person get-togethers. Polling at Q&A 

proved there was still interest. The board chose an evening out at Big Rig Brewery & Restaurant. Members and non-

members are welcome. 

 When: Wednesday, November 26th starting at 7:00pm. 

 Where: Big Rig Brewery & Restaurant, 1980 Ogilvie Rd (in the Gloucester Centre)  

https://bigrigbrew.com/restaurant/locations/ottawa-ogilvie/ 

 

Wednesday evening was chosen as a lot of members already 

block off Wednesday evenings to attend Q&A. The location 

was chosen for several reasons: 

 easy to get to: 

 https://maps.app.goo.gl/8rdtztXyvbHVzVCt9 

 just off the 174 at Blair & Ogilvie 

 at the Blair station for anyone taking the O-train 

 lots of free parking 

 last event (pizza party) was in the west end 

While the OPCUG is making the reservation, all attendees will 

pay their own tab. 

We need to let Big Rig know how many people we expect. If 

you hope to attend, please send an email by November 12th to 

SuggestionBox@opcug.ca and let us know the number of peo-

ple who will be in your party. 

CLUB LIFE 

Nominations for OPCUG Board for 2026 

O nce a year, the OPCUG holds elections for the 9-member Board of Directors. We are once again coming up to this annual 

event. 

We encourage all members to consider running for a board position or getting involved in some other manner in the operations 
of the OPCUG.   

If you want more information about what is involved, please talk to me or any current or past Board 

member. Names are listed in the Newsletter and on the web site. 

Nominations can be submitted via email to Lynda Buske, Election Chair, at:  
nominations2026@opcug.ca. 

Nominations must be received by midnight, December 31, 2025. 

Please get involved.  Please help the OPCUG continue in its role of  Users Helping Users! 

 

Lynda Buske 
Election Chair 

https://bigrigbrew.com/restaurant/locations/ottawa-ogilvie/
https://maps.app.goo.gl/8rdtztXyvbHVzVCt9
mailto:SuggestionBox@opcug.ca
mailto:nominations2026@opcug.ca
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Cleaning your camera sensor 

by Lynda Buske 

S ensor spots in digital photography occur when something like a spec of dust sticks on your sensor, blocking light from 

getting to that area of the senor, resulting in a dark spot on your photograph. Sensor spots tend to be most visible 

when you are shooting with a small aperture. If you discover what you believe are sensor spots on your image, you can 

remove them with functions in photo editing software such as spot remover, healing brush, perfect eraser, etc. (depending 

on the software). In the free Photoscape X, use Tools/Spot healing brush. You can also use a clone brush to copy over some 

pixels from beside the sensor spot. [Note: clone tools are not usually available in free versions of photo editing software] 

To make sure it doesn’t happen the next time you shoot, check first that your lens is clean. Then take a photo of a plain 

surface (like a wall) and even better try to shoot it out of focus. Then examine your image and see if there are spots that 

weren’t on the wall. If there are, it means your sensor needs a clean. More advanced software such as Adobe Lightroom or 

ON1 Photo RAW can give you the option to home in even further (see images below). In Adobe Lightroom, use Develop 

Module > Spot Removal tool > checkbox Visualize Spots. 

Dirty – Some sensor spots visible       

 

 

 

 

 

 

 

 

 

Really dirty – more sensor spots visible 

 

Visual dust feature in ON1 Photo RAW 

 

 

 

 

 

 

 

(Continued on next page) 

A guide to digital photography for computer enthusiasts. After the click of your camera, you’re only half done! 

THROUGH THE LENS 
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To clean your sensor, make sure you are indoors in a relatively dust-free environment. The least expensive option is a hand blower 

(less than $15). However, spending a little more ($30- $130) means you can get a filter on the air intake which is a great feature. 

This means you prevent the possibility of the blower pushing dust onto your sensor from the air in your room. I highly recom-

mend this second option. 

$12 – not recommended         $30 – blower has filter                         $130 – blower has filter 

 

 

 

 

 

 

 

 

 

If there are still sensor spots appearing on your images, you may require a wet clean.  

This can be done by purchasing wet sensor swabs ($1-$2 per swab) but make sure to  

get the size that matches your sensor (i.e. full frame, APS-C, micro 4/3) . 

 

 

 

 

 

Other options that I have not tried are sensor brushes ($25-$45) and sensor gel sticks ($20-$70). 

Sensor brush ($25-$45)    Sensor gel sticks ($20-$70) 

 

 

 

 

 

 

 

 

 

To minimize sensor spot accumulation: 

 Change lenses in dust-free environments 

 If available, use camera’s sensor shield (e.g. Nikon Z8, Z9) 

 Aim opening downwards when changing lenses since dust more likely to fall down than up 

 Use built-in camera sensor cleaning function which vibrates the sensor to shake off dust 

 

Camera sensor   (Continued from previous page) 

Read all of Lynda’s articles here. See her presentations at the Ottawa Public Library (select Lynda Buske as Organizer). 

https://opcug.ca/digital-photography/
https://opcug.ca/mec-category/opl-presentations/
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THE CONFUSION OF PROGRESS 

A MONITOR Back to Basics article (March 2025) 
by Jim Cerny, 1st Vice President,  
Sarasota Technology Users Group (https://thestug.org/) 
jimcerny123 (at) gmail.com 

 

I  keep forgetting that all the companies providing apps, big or small, are doing so for only one reason – to make money! 

Microsoft, Google, Apple, all want your money. I guess you can’t blame them in this free economy, especially if you in-

vest in them, but I think they are really omitting a big market (and more profit) by ignoring what we seniors want and need 

from technology. They concentrate on the big percentage of their customers who demand more options, multiple devices, 

business applications, multi-screen monitors, and expensive tech gear affordable to businesses and higher-paid profession-

als. These providers claim their on-going changes are improvements, but such changes to us seniors are very burdensome. 

Here are some thoughts to keep in mind which, I hope, will help you steer through the ever-more complex high-tech path 

without too much frustration. 

 

1. Want to pay them every month forever? It used to be in the old days that you would buy your software (apps) 

ONCE and it was yours to do with as you please. But today, oh no, you RENT the apps and pay a monthly or an-

nual fee. They love you to use “auto-pay” to make it easy for you to forget that your paying them over and over 

again. 

2. Thousands of options are enjoyed by those tech users but only confuse us “basic” users. Too many options (or “bells 

and whistles”) for documents, photos, spreadsheets, and other apps. Even simple solitaire games give you too many 

choices of card styles, backgrounds, re-deals, point scoring, timers, replays, and yes, the ever-present ADS! Now 

apps not only show ads before or after you are using them, they are also interrupting your play (or work) with ads 

while you are using the app. 

3. Bogus search results. I used to use a search engine and felt pretty confident that the search results were real, pointing 

me to valid websites, answering my questions, and no roadblocks or detours. Today the top results of any search 

probably list advertisers and companies who have paid money to be there first in your face. They hope you click on 

them so they can act as a “gateway” to what you are really looking for. Trying to download a new app or game may 

get you to a “middleman” who wants to come between you and the actual company that provides the app. Be care-

ful! Try to carefully look at the web address to make sure it is actually the company website you want. 

4. Clicking on the wrong “download” box. Even real company websites blatantly offer other apps or downloads that 

are NOT the one you want. Look carefully – the real download is hiding in a forest of other products. Even down-

loading the one you really want may “piggyback” another app you do not. 

5. Surveys, verifications, emails, links, websites, ALL can be BOGUS and actually look like a real company website or 

email. Use another method to confirm before you use them. 

6. Can’t talk to a human ever? Ever play their “Contact us” game? It really means try to text or email and see if anyone 

cares. Phone trees do not branch to what you really want or need. Your doctor’s office tells you to contact the phar-

macy to get a refill of your prescription, but your drug supplier is not given the “ok” from your doctor. 

7. Tiny invisible buttons on laptops, labels way too small to read, fumbling around to press the right part of a touch-

pad, skinny or invisible scrollbars, and more – hidden, can’t tell if you pressed a button or not (buttons really don’t 

move in or out anymore). 

 

 

Hello! Is anyone out there listening? Stop ignoring those of us with simple tastes, simple tasks, bumbling fingers, and weak 

eyes. Give us back the simple easy to use apps – you can always add a box to click on for “Lots more confusing and com-

plex options” if anyone wants them! 

Thanks for listening, I feel better now, I hope you do too! 

 

 

APCUG 

https://thestug.org/
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Where to Get E-Books 

By Tom Burt, Vice President 
Sun City Summerlin Computer Club 
https://www.scscc.club 
tomburt89134 (at) cox.net 
 

A s we approach summer, a perennial challenge is to find 

new, interesting, fun books to read. Lately, e-books 

have been a popular choice. With the maturing of the elec-

tronic book (e-book) format and industry, it should be more 

accessible than ever to find the right title, purchase it, 

download it to your book reader, smartphone, or tablet, 

and read it. In practice, things aren't quite that simple, so 

you may want to read on. 

 

This article is based on a seminar I gave titled "E-Books 

and E-Readers." My seminar slides are at: 

https://www.scscc.club/smnr/E-BooksandE-

ReadersSeminar-2024.pdf. 

 

E-book formats 

 

There are two main e-book formats: Amazon Kindle and E

-Pub. There are hardware and software readers for each. 

Both formats support digital rights management (copy pro-

tection) so that the purchaser of a book can't share it with 

more than a few others. Amazon mainly uses the Kindle 

format. E-Pub is used by Barnes & Noble and Kobo and for 

many self-published books. Adobe PDF and HTML are 

also often used for e-books. Apple's iBook format is a varia-

tion of E-Pub. 

 

When buying an e-book, it's essential to know its format so 

you can be sure your reader device or program can retrieve 

and display the book. A common problem for Amazon's 

Kindle or Fire tablet owners is that they do not support the 

E-Pub format; you need to convert the EPUB file to Ama-

zon's proprietary format, AZW, using a conversion tool 

like Calibre. 

 

E-Book Websites 

 

Here's a list of e-book websites with links to each: 

 

 Amazon Kindle Store www.amazon.com 

 Barnes & Noble http://www.barnesandnoble.com 

 Google Play Store Books https://play.google.com/

store/books 

 Kobo www.kobo.com 

 Las Vegas / Clark County Library (via OverDrive) 

http://lvccld.org 

APCUG 

 Apple Books https://www.apple.com/apple-books/ 

 Open Library https://openlibrary.org/ 

 Project Gutenberg (60,000 free e-books) https://

www.gutenberg.org/ 

Let's look at a few of them in more depth. 

 

Amazon Kindle 

 

The Amazon bookstore is vast. You can buy books in hard-

cover, paperback, audio, and e-book format. As with all 

Amazon shopping, the search is very smart, and you can set 

filters to narrow choices. You can click on items in the 

search results to view details and add them to your shopping 

cart. 

 

E-books are delivered (downloaded) to the reading device 

you specify if buying for yourself. You can also specify that 

you are buying for someone else and enter the giftee's infor-

mation so they can receive the book. 

 

You need an Amazon Kindle or Fire Reader tablet or Ama-

zon's free Kindle Reader app to read Kindle books. There 

are Windows, macOS, Linux, Android, and iOS versions. 

 

If you subscribe to Amazon Prime, you can access an exten-

sive collection of e-books at no charge via the Prime Read-

ing service. You can access up to ten e-books for as long as 

you wish. When you want another, return or buy one of the 

ten you have. 

 

The Amazon Fire HD 8 tablet with 64 GB of storage cur-

rently costs $129.99. 

 

Barnes and Noble 

 

Barnes and Noble sells books in "Nook book" (E-Pub) for-

mat, paperback, and hardcover. B&N also sells a family of 

Nook reader tablets and has a free reader app. You can set 

up an account on B&N and enjoy special pricing, free e-

books, and other perks. 

 

The Nook book reader is a 10.1-inch Lenovo Tab M10 HD 

Tablet, Android 9.0, with 32GB Storage. It has full access to 

the Google Play Store apps. This would include the free 

Amazon Kindle Reader app for Android. So, a Nook reader 

tablet could double as a Kindle Reader, allowing you to 

shop for books in either Nook or Kindle format. 

 

 

(Continued on page 9) 

https://www.scscc.club/
https://www.scscc.club/smnr/E-BooksandE-ReadersSeminar-2024.pdf
https://www.scscc.club/smnr/E-BooksandE-ReadersSeminar-2024.pdf
http://www.amazon.com/
http://www.barnesandnoble.com/
https://play.google.com/store/books
https://play.google.com/store/books
http://www.kobo.com/
http://lvccld.org/
https://www.apple.com/apple-books/
https://openlibrary.org/
https://www.gutenberg.org/
https://www.gutenberg.org/
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How about Microsoft  Word and LibreOffice 

Writer? 

In Microsoft Word, you can easily compare something 

on page 2 with what appears on page 11. 

This works in LibreOffice as well, if that’s your office 

suite of choice. Click the Window menu and choose New 

Window. As expected, this also works in LibreOffice 

Impress and Calc. 

 

Foxit Reader has two ways  

Imagine you are viewing a PDF document in Foxit 

Reader with lots of unfamiliar technical terms. Click 

the View menu and choose Split. In the right panel, 

scroll to the glossary. Keep it visible while reading the 

main text in the left pane.  

If you prefer having the views in separate Foxit Reader 

windows, click on File > Preferences > Documents > Allow 

multiple instances. Then open the PDF file twice and 

scroll through the content independently in each win-

dow. 

 

(Continued on next page) 

Opening a new window of the same spreadsheet 

Excel will open another separate window. Arrange the windows on your 

desktop so both are visible. In one, click the Data tab and in the other, click 

the Chart tab. As you manipulate the numbers, you will immediately see the 

updated chart in the other window.  

Separate tabs for data and chart 

 

Working in Microsoft  PowerPoint   

This works in other programs as well. Imagine in PowerPoint you are creat-

ing an Agenda slide. By having two windows into the presentation file, you 

can scroll through the slides and add content to the agenda slide.  

Peering   (Continued from page 1) 



 Page 9 

 Volume 42,  Number  9  

 

Web browsing 

While viewing a web page, click the mouse wheel while the 

mouse pointer is over the Refresh button to open the same 

page in a new tab. Drag the duplicated tab out into its own 

window. Arrange the two browser windows so you can see 

both and scroll the content in the two views independently. 

 

Summary 

Creating two views into the same document is very handy 

any time you need to see more than one portion of a docu-

ment at the same time. 

Many other programs allow you to have multiple views into 

a single document. To find out if your program XYZ sup-

ports it, browse to https://www.perplexity.ai/ and ask Can I 

view different parts of a document at the same time using XYZ? 

Keep in mind that in all these cases, you are looking at two 

views into a single document. Any modifications made in 

one view are reflected in the other view. 

 

 

 

 

(back to Table of Contents) 

Peering   (Continued from previous page) 

Project Gutenberg 

Project Gutenberg was founded by Michael Hart, who 

invented e-books in 1971. Its website claims to have 

60,000 titles in its library. All these titles are completely 

free. Most are "classics" that are out of copyright. For 

example, I searched for Albert Einstein and found an 

English translation of his Special and General Relativity 

expositions. 

 

I tried downloading a copy of Herman Melville's "Moby 

Dick" in Kindle format and was able to read it using the 

free Calibre book reader app on my PC. The Amazon 

Kindle Reader app wasn't able to open the book. I'll try to 

find out why and see if I can copy the e-book to my Ama-

zon Fire tablet and read it there. 

 

Hopefully, that will help you learn 

more about e-books and how to get 

them. I love them because of their 

convenience and ease of reading. 

And they take up zero space in the 

house. 

 
 

 

 

 

 

E-Books   (Continued from page 7) 

Quick Tip 77: starting Task Manager 

by Chris Taylor 

Task Manager is a great tool for trouble-shooting performance problems in Windows. I show how to use it extensively in 

my Windows Performance Tune-up presentation, which I frequently give at branches of the Ottawa Public Library. 

There are quite a few ways to start Task Manage including: right-click a blank space on the Taskbar and choose Task 

Manager from the pop-up; press Ctrl+Alt+Del and choose Task Manager; press Win+R and type in taskmgr; click the 

Start button, type Task Manager, and select the icon from the results; as well as others. 

All of these methods have a potential problem: if you are trying to get to Task Manager because you want to troubleshoot 

after Windows has become non-responsive, you may not be able to get the pop-up menus or icons where you can launch 

Task Manager! 

Instead, press Ctrl+Shift+Esc. Besides being the fastest method, it is almost certain to work as long as Windows is func-

tioning at all. The reason is Ctrl+Shift+Esc uses the Winlogon process to create a Task Manager process and spin it up on 

your desktop. It is not dependent on the Windows shell (the desktop elements) working. By definition, Winlogon is still 

working or your computer would have already blue screened, so you can almost always get an instance of Task Manager 

using Ctrl+Shift+Esc. 

 

https://www.perplexity.ai/
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O T T A W A  P C  N E W S 
 
Ottawa PC News is the newsletter of the Ottawa PC Users’ Group (OPCUG), and 
is published monthly except in July and August. The opinions expressed in this news-
letter may not necessarily represent the views of the club or its members.  

Member participation is encouraged. If you would like to contribute an article to Otta-
wa PC News, please submit it to the newsletter editor (contact info below).  

To receive the monthly newsletter by email, send an email to:  
opcug-newsletter+subscribe@googlegroups.com  (leave subject and body fields blank) 
You do not need to create a Gmail or Google Groups account. 

To subscribe to other OPCUG Google Groups member services, go to: 
https://opcug.ca/google-groups-how-to/  

 

Group Meetings 

OPCUG meets on the second Wednesday in the month, except July and August, at 
the Riverside United Church, 3191 Riverside Drive, Ottawa. Parking is free at the 
church. OCTranspo bus #90 stops nearby. Details at https://opcug.ca/venue/. 
 
NOTE: Until further  notice, all our  events are via video conference.  
Details at https://opcug.ca/venue/ . 
 
 

OPCUG Membership Fees:  $20 per year 
Mailing Address:   3 Thatcher St., Nepean, Ontario, K2G 1S6 
Web address:   https://opcug.ca 
Follow us on Facebook:  https://www.facebook.com/opcug 
Follow us on X:   https://x.com/opcug 
 
 
President and System Administrator 
 Chris Taylor       chris.taylor@opcug.ca 
Treasurer 
 (Mr.) Jocelyn Doire jocelyn.doire@opcug.ca 
Secretary 
 Gail Eagen       gail.eagen@opcug.ca 
Meeting Coordinator 
 Alan German  meetings@opcug.ca 
Membership Chair 
 Lynda Buske   membership@opcug.ca 
Newsletter 
 Brigitte Lord   newsletter@opcug.ca 
 (editor/layout/e-distribution)    
Public Relations 
 Vacant   PR@opcug.ca 
Facilities 
 Bob Walker   bob.walker@opcug.ca  613-489-2084 
Webmaster 
 Brigitte Lord       webmaster3@opcug.ca 
Privacy Director 
 Stewart Bruce  privacy-opcug@opcug.ca 
Special Events Coordinator 
 Bob Herres  bob.herres@opcug.ca  
Director w/o Portfolio  
 Karen Wallace-Graner karenwg@opcug.ca 
 

© OPCUG 2025.  

Permission is granted* for republication of articles by not-for-profit organizations, journals, or publications, 
provided publication and author credit is given, the article's content is not modified without permission, and a 
copy of the publication is forwarded to newsletter@opcug.ca. 
 
*Permission is granted only for articles written by OPCUG members, and which are not copyrighted by the 
author. See https://opcug.ca/copyright-and-usage/. 
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video conference (details at https://opcug.ca/venue/). 
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Follow us on X:    https://x.com/opcug 
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Treasurer 
 (Mr.) Jocelyn Doire  jocelyn.doire@opcug.ca 
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Membership Chair 
 Lynda Buske   membership@opcug.ca 
Newsletter 
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 (editor/layout/e-distribution)    
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Facilities 
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Q&A IS ON-LINE! 
Weekly! 

 

Since the pandemic, the OPCUG has 

been holding weekly Q&A sessions 

in Zoom video-conferences. 

Join us every Wednesday (except on 

regular monthly meeting nights) at 

7:30 pm to discuss computer issues. 

Questions (and answers) on any com-

puter-related issue are welcome.  Or, 

do you have a favourite computer 

program or topic that you would like 

to share with the group?  Send your 

questions, answers, or the details of 

what you would like to share to:  

SuggestionBox@opcug.ca 

Everyone is welcome to attend Q&A 

sessions and to ask questions about 

their specific computer-related prob-

lems.  Join us at: https://

tinyurl.com/opcug-meeting (if you 

use the Zoom client, the meeting ID 

is 924 9556 0898 and the password is 

opcug). 
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